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Highlights
Some of the most important enhancements in GibbsCAM 2025 are as follows:

• OptiThreading — This Sandvik Coromant technology is tuned for cutting complex
thread profiles or in high-strength alloys or exotic materials. It enables controlled
chip breaking, no vibration marks, and higher surface finish in thread turning
applications, and it can extend tool life. For details, see “OptiThreading”.

• GibbsCAM Copilot— An AI-powered chat tool to help users solve problems
interactively. For details, see “GibbsCAM Copilot: AI-powered chat tool”.

• Op Tile List— For MTM models, new Op tile list buttons let you set the
mode for displaying flows. For details, see “New modes for Op Tile List: Columns for
flows”.

This “Highlights” section is just a small subset of the enhancements in GibbsCAM 2025.
The next section (Overview of What’s New) provides a complete list.

Overview of What’s New

Enhancements to Milling include:

• Mill > Holes > Mill Feature: With Top Surface Z choice Automatic, you can now specify
an incremental offset that will be applied to all selected features.

• Mill > Roughing: For Pocket toolpath, you can now optionally machine pockets in
the order they were selected.

• Mill > Lead-In / Lead-Out: New options for lead-in and lead-out let you combat tool
deflection by cutting past the edge of the material.

• A new plug-in, up2parts autoCAM, lets you import up2parts bundles that contain
proposals and recommendations for machining steps, operations, and tools.
Importing the bundle generates processes, operations, and toolpath that you then
refine using GibbsCAM.

For details, see “Milling”.

Enhancements to Turning include:

• OptiThreading: This Sandvik Coromant technology enables controlled chip
breaking, no vibration marks, and higher surface finish in thread turning
applications.
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• Roughing: A new choice for Rough Type, Rib Cut, reduces tool deflection and
improves tool life.

• Swiss-style machines now support sliding headstocks and Z axis limits.

For details, see “Turning”.

GibbsCAM 2025 has many enhancements to Visualization and User Interface:

• GibbsCAM Copilot: An AI-powered chat tool helps you solve problems
interactively.

• Op Sim and Machine Sim now provide graphics to indicate spindle direction for
both tool and part.

• A new Edit > Selection menu option, Filter Selections, can help you to refine
your geometry selections, opening a dialog that lets you include/exclude various
kinds of points, lines, circles, curves, text, PMI, etc., for overlap mode or mouse
drag.

• In Machine Sim, Collision Checking and Program Error Check are now
enabled by default for newly created parts.

• In Op Sim, Analyze Cut Part now lets you supply a value for Tolerance.

• Op Tile List— For MTM models, new Op tile list buttons let you set the
mode for displaying flows. You can redraw toolpath in one easy action: Simply
Ctrl+click or Shift+click an operation tile. In Op Sim and Machine Sim, you
can set a new Stop type: Stop Before Every Operation. When Simulation is running, the
Sync Control dialog provides a graphical indicator (a moving red bar) that shows
the progress of the simulation as it executes.

For details, see “Visualization and User Interface”.

Improvements to Tooling:

• Additional tool cutting parameters like Ae (Cut Depth) and Ap (Cut Width) can be
stored with tool cut data.

• A link in the Tool dialog, , appears when the current tool is known to
be available from a supported tool library manufacturer, so that the tool can be
ordered immediately.

For details, see “Tooling”. Also see “OptiThreading”.

Improvements to Posting and Output:

• TMS now supports full WFO system functionality.
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• Postprocessors can now query and output programmed machining tolerance for
operations on solids.

For details, see “Posting and Output”.

Enhancements to Solids include:

• Ability to edit facet bodies: Boolean, offset/shell, History, heal, refacet, tessellate,
and more.

• Collision avoidance of workspace fixtures and Intermediate Fixtures.

For details, see “Solids”.

Miscellaneous improvements and changes:

• Copying/pasting of solids now preserves colors and other attributes.

• NLO now allows License borrowing with checkout/return capabilities.

• Op Manager and Process Manager support VoluMill data fields.

• Op Manager and Process Manager support many 5-Axis data fields.

• MDDs can now set maximum spindle RPM for parts and tools.

• VoluMill 9.6 is now supported

For details, see “Miscellaneous”.

Improvements to 5-Axis:

• Integration of ModuleWorks 2024.04, 2023.12, and 2023.08.

For details, see “5-Axis”.
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Milling
GibbsCAM 2025 includes several important Milling enhancements.

Mill Feature > Top Surface Z=Auto: Auto+
value for incremental offset
Where to find it: Mill > … > Mill Feature tab; for Top Surface Z, choose Automatic: Auto+
textbox.

In Milling processes that have Mill Feature tab, when Top Surface Z is Automatic, you can
enter a value in the Auto+ textbox that provides a global incremental value above the
detected Top Surface Z.

This replaces the previous interface, where the value in the Automatic textbox was
automatically 0.



Milling

9

Pocket / Contour: Ability to machine pockets
in selection order
Where to find it: Mill Roughing/Contouring, left tab: Mach. Order pulldown option From
Selection.

In Milling processes Roughing (Pocket tab) and Contour (Contour tab), you can now
instruct the system to create toolpath in the order of the user’s selections. The previous
option (Automatic) instructs GibbsCAM to determine the order.

Lead In / Lead Out: Open Sides > Overlap
Finish Walls
Where to find it: In Mill process dialogs, with Material Only: Open Sides textbox Overlap
Finish Walls.
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In all Milling processes, a new parameter when Material Only is enabled lets you cut
past the edge of the material, recutting a short section of the finish wall. (The value 0,
meaning “no overlap”, is the previous and default behavior). You can use this to combat
tool deflection and increase tool life.

Plug-In: up2parts AutoCAM
The up2parts AutoCAM plug-in lets you import up2parts *.zip files and use the results to
generate GibbsCAM operations, toolpath, simulation, and G-Code.

Workflow: On the up2parts Website

The following steps can be done by anyone familiar with up2parts, not necessarily a
GibbsCAM user.

1. The user supplies credentials to the up2parts website and then uses up2parts to:

a. Specify a solid model in STEP format. Note that AP242 includes PMI and
tolerance information, but AP203 and AP214 do not.

b. Start the up2parts geometry analysis and AI-based feature recognition.

c. Get a technical description that includes recognized features like pockets, holes,
countersinks, and surfaces.

4. Then, up2parts calculation is used to generate a work plan by defining the machine,
material specification, and general tolerance (ISO-2768).

5. Next, up2parts proposes a CAM project for six-sided machining that includes
“clamping” (approach from top/bottom/left/right/front/back), tools, machining
steps, and operations. The up2parts interface allows adjustments and refinements to
this proposed project.

6. After the project is confirmed, up2parts bundles its proposals and recommendations
into a *.zip file readable by GibbsCAM. This .zip file includes: the solid model in
STEP format with complete feature tree; stock information; tooling; features with
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operations; and meta information for clamping. Associated PMI (product
manufacturing information), if any, is preserved.

Workflow: Within GibbsCAM

Before you begin: Set the units in your DCD to match the units of the up2parts bundle
(usually mm).

1. On the Plug-Ins menu, under Main Tools, click up2parts autoCAM.

2. In the up2parts program arguments dialog:
(for Selected file): Supply the *.zip filename of the bundle prepared by up2toparts.
(for Select clamping): Select a folder to specify approach:
top/bottom/left/right/front/back.
Click Import.

3. Notice that progress is shown by status bar at the bottom of the GibbsCAM window.
When the import process is complete, GibbsCAM displays the model in the
workspace. Then, watch as features are processed and operations are generated.
Finally, in response to the message “The part is loaded and processes/operations
have been created”, click OK.

4. You can inspect and optionally modify any aspect of the GibbsCAM model,
including tooling, processes, parameter values, and operations. You can then use any
of the native GibbsCAM Simulation options to visualize the machining operations
and to find/correct any toolpath issues.

5. Use the appropriate GibbsCAM postprocessor to generate G-Code for your specific
machine.
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Turning

OptiThreading
GibbsCAM Turning is significantly enhanced in Version 2025 by the addition of
OptiThreading. This Sandvik Coromant technology enables controlled chip breaking, no
vibration marks, and higher surface finish in thread turning applications.

Where to find it: The Threading process dialog, under
Definition, now offers a third choice (below From Parameters
and From Shape): From Cutting Data. This is active when
the process uses a Threading tool that has been imported
from CPTL (CoroPlus Tool Library) with recommended
cutting data. If you do not yet have such a tool, see Using
the GibbsCAM CPTL Plug-In below.

If the tool has OptiThreading data, From Cutting Data turns off some of the default
interface and lets you specify OptiThreading-specific parameters like Oscillation
Frequency (Coarse/Normal/Fine), a value for Oscillation Extra Lift Distance, and a checkbox
for Extra Oscillation Final Rough Pass.
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Using the GibbsCAM CPTL Plug-In
As in GibbsCAM 2024, you import tools from the CoroPlus Tool Library (CPTL) by
starting the CPTL plug-in and using the CoroPlus Tool Library Importer dialog.

Please Note: To use the GibbsCAM CoroPlus Tool Library Importer, you must have a
valid and active CPTL account and tool data (tools, holders, cutting data, etc.)

Starting CPTL Using the Plug-InsMenu

Where to find it: On the Plug-Ins menu, under Main Tools, click CoroPlus Tool Library.
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Starting CPTL Using the Process Flyout

Open the Select Tool Type flyout, either by double-clicking a blank process tile and
selecting a process or by right-clicking an occupied process tile and choosing context
menu item Change Tool. Then, in the Select Tool Type flyout, click CoroPlus Tool Importer.
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Context menu from right-clicking an
occupied process tile.

Select Tool Type flyout

If you are not already logged in to your Coromant account, the Login dialog prompts
you to enter your credentials.

Result: After the connections are initialized, the CoroPlus Tool Importer dialog
appears.
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Within CPTL, Create and Export an OptiThreading
Assembly
To create, modify, and export an OptiThreading tool assembly, follow these steps.

1. Create a new tool assembly: By application > Symmetrical rotating.
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2. Under Task: Select the workpiece material (for example: Low alloy steel).

3. In response to the prompt, clickWorkpiece parameters and then choose
workpiece geometry by clicking the labels attached to the sample picture. For
example:
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4. In the ensuing boxes and drop-down menus, specify parameters for the workpiece,
such as TDZ=Thread diameter size; THL=Threading length; THDH=Thread hand;
TCTR=Thread tolerance class). Then, below the thread specifications, under the
OptiThreading pulldown, toggle OptiThreading enabled from gray (OFF) to ON (light
blue).

Please Note: The OptiThreading toggle must be ON to enable the
OptiThreading technology.

5. After completing your selections, click the Get results button at the bottom of the
first column.

6. Click the Build tool assembly button near the bottom of the third (“Cutting Data”)
column.
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7. In the left column of the tool assembly screen, enter values for Name, Description,
and Classification.

8. Optionally, use controls in the top
center of the tool assembly screen:

The buttons rotate/reset the view rotation.

The button confirms/resets the view settings, as illustrated here:
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The pulldown menu sets the style, from: 3D model, 2D drawing, or 2D family drawing.

You can also view the assembly’s Properties ( ), Parameters ( ), and Connections (
).

9. In the left column of the tool assembly screen, click the Save button (or Save As).

10. After the assembly is saved, you can optionally click the Cutting Data ( ) button
and use options like Get recommendations or Specify own cutting data. You can override
( ), edit( ), copy( ), or delete( ) the data displayed in this screen.

11. When you are satisfied with the tool assembly and its data, click Export GTC package.

Result: The OptiThreading tool assembly is exported and available for selection in the
GibbsCAM CPTL plug-in( ). In the plug-in, after a GibbsCAM user selects this
assembly, clicks the Send to GibbsCAM button, and sets the tool orientation, the
corresponding tool is brought into GibbsCAM, where it is associated with cutting data
(as shown by the ☑ mark in the Cutting Data ( ) button in the Tools dialog).

Within the GibbsCAM Turning Thread process dialog, this data can be accessed by
clicking the Tool ☑ ( ) button. More importantly, the dialog's Definition
section offers the option From Cutting Data, which provides access to the options and
parameters specific to OptiThreading.

When to Use the OptiThreading Process

High-Precision Applications: OptiThreading is ideal for applications that require high
precision and accuracy in threading operations, as in aerospace, automotive, medical
device manufacturing, and any industry where precise thread profiles are critical.

Complex Thread Profiles: It is particularly beneficial for cutting complex thread
profiles that are difficult to achieve with traditional threading methods. This includes
multi-start threads, tapered threads, and nonstandard thread geometries.
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Material-Sensitive Operations: When working with materials that are challenging to
thread, such as high-strength alloys and exotic materials, OptiThreading optimizes
cutting conditions to minimize tool wear and avoid workpiece damage.

Tool Life Optimization: To extend tool life and reduce tool costs, optimization of
cutting parameters reduces the wear on threading tools, leading to fewer tool changes
and lower overall costs.

Surface Finish Requirements: In scenarios where an excellent surface finish is
required, such as in the production of critical components like hydraulic fittings and
sealing surfaces, OptiThreading ensures superior surface quality by minimizing
deflection and vibration during the threading process.

Long chips: Long chips tangling around workpiece and/or tool can cause unwanted
stops in production. OptiThreading will help in these scenarios due to the oscillating
movement in and out of the workpiece.

Why OptiThreading Is Used

Enhanced Efficiency: OptiThreading significantly improves the efficiency of threading
operations by optimizing cutting parameters such as speed, feedrate, and depth of cut.
This leads to faster production cycles and increased throughput.

Improved Thread Quality: By carefully controlling the cutting process, OptiThreading
produces higher-quality threads with better dimensional accuracy and surface finish.
This is crucial for components that must meet strict tolerances and quality standards.

Reduced Tool Wear: OptiThreading reduces tool wear by optimizing cutting
conditions, which leads to fewer tool changes and lower tooling costs. This is especially
important when working with or ductile abrasive materials that can quickly degrade
cutting tools.

Minimized Material Stress: The optimized cutting strategy minimizes stress and
deformation in the workpiece material, reducing the risk of defects such as thread
tearing or surface cracking.

Versatility: OptiThreading can be adapted to a wide range of threading operations and
materials, making it a versatile solution for various manufacturing environments. It
supports different threading types and can be used on both CNC lathes.

Competitive Advantage: Manufacturers implementing OptiThreading can achieve
higher productivity, better thread quality, and reduced operational costs, providing a
competitive advantage in the market. This technology lets companies meet stringent
customer requirements and deliver superior products.
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In summary: OptiThreading is used in situations where precision, efficiency, tool life,
and surface finish are critical. Its ability to optimize the threading process makes it an
invaluable tool in modern manufacturing, particularly in industries demanding high-
quality threaded components.

Roughing > Rib Cut
Where to find it: Turning > Rough; for Rough Type, choose Rib Cut
Plunge.

This new Turning strategy consists first of a preliminary pass
where the tool repeatedly plunges into the part at full
engagement to create a series of cuts with each cut more than a
tool-width away from the previous one. Then the next pass cuts
the remaining “ribs”. Rib cutting avoids tool deflection in both
passes, and it offers excellent chip control. The rib cuts can be
made safely at high speed to decrease the total amount of cycle
time.
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Swiss-style machines: Sliding headstocks and
Z-axis limits
Where to find it: In Machine Manager, for node type (lathe spindle): ☑ Headstock
Origin.

The new Headstock Origin checkbox lets you provide a value for the distance between the
front of the guide bushing and your headstock’s 0 position. This lets you correctly
position Simulation bodies on the headstock axis, and it provides a more intuitive
interface in the DCD for Swiss-style machines.
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Visualization and User
Interface

GibbsCAM Copilot: AI-
powered chat tool
Where to find it: On the Help menu, click
GibbsCAM Copilot.

GibbsCAM Copilot is an AI-powered chat tool — a ChatGPT LLM (large language
model) that has been trained on a wide variety of source material relating to GibbsCAM.
It lets you access information without having to search through documentation or call
Technical Support. It can respond in any of the languages supported by the GibbsCAM
user interface. A “thumbs-down” feedback mechanism allows you to register
dissatisfaction with any reply. GibbsCAM Copilot works best when responding to
specific queries that are narrowly worded.

Please note that, because some countries’ laws relating to AI are not yet fully analyzed,
the GibbsCAM Copilot chatbot is disabled in some countries.
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Rotary Hints: Op Sim / Machine Sim
indication of spindle direction
Where to find it: On the context menu for the Rendering dialog’s title bar, enable Show
Rotary Hints.
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Quick and Powerful Improvements to
Selection

Edit > (Selection >) Filter Selections

Where to find it: On the Edit menu, under Selection, click (Filter Selections) to open
the Selection Filter dialog shown below.
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Items selected/deselected via the Selection Filter dialog can be stacked.

Deselect by Mouse Drag

Complementing the existing command “Select by Mouse Drag” is a new command,

“Deselect by Mouse Drag”. Each command has its own default keyboard shortcut,
such as Shift+drag to select and Ctrl+Shift+drag to deselect. These actions can be
stacked.

Containment and Overlap Mouse Drag: Left-to-right and
right-to-left
In previous releases, left-to-right mouse drag selection has been inclusive: It selects any
entity that is even partly within the drag region. A new feature is mouse drag selection
that is exclusive: The system selects only entities that are entirely contained within the
drag region.
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File > Preferences offers a new toggle (left-to-right inclusive containment as in
previous releases; or, instead, right-to-left inclusive containment coupled with left-to-
right exclusive containment).

Simulation default: Collision Checking,
Program Error Checking

Where to find it: In Sim dialogs, for new parts, notice that  Collision Checking and 

Program Error Checking are now enabled by default.

Sync Manager during Sim: Graphical indicator
of Simulation progress
Where to find it: In the Sync Control dialog (except in Uniform view) while Simulation
is actively running, a red bar indicates the timeline of the simulation as it progresses
through the flows.
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Op Sim Analyze Cut Part can use user-set
tolerances
Where to find it:With a solid selected, run Op Sim and then, after completion, click
to open the Analyze Cut Part dialog and supply a value for Tolerance:
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New Stop type in Simulation: Stop Before
Every Operation
Where to find it: In any Sim Rendering dialog, click to open the Stops dialog. If
you want to review every operation individually, check the Stop Before Every Operation
checkbox before running Sim.

New modes for Op Tile List: Columns for flows
Where to find it: Near the top of the Op Tile list, a new
set of buttons — — lets you set the mode for
displaying flows:

• Show All Flows

• Show Each Flow

• Sync Flow Mode
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Show Each Flow Sync Flow Mode

Quick-and-easy toolpath redraw
Where to find it: In File > Preferences > Interface, in the upper right of the pane, option
buttons let you specify the behavior of single-clicking an Op tile-tab or single-clicking
an Op tile.

You can set a preference to redraw toolpath in one easy action either when you click an
operation tile tab number or when you click an op tile itself.
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Tooling
GibbsCAM 2025 brings further improvements to tools and tooling.

More tool parameters stored with tool data,
such as Ae and Ap
Additional tool cutting parameters like Ae (Cut Depth) and Ap (Cut Width) can be
stored with tool data. For tools that have such parameters imported from systems like
CPTL = CoroPlus Tool Library, these additional parameters are automatically available.

Where to find it: The Tool dialog and most process dialogs have a button
that signals the presence of tool cutting parameters stored with the tool. Clicking this
button opens a dialog resembling the following:

Also see additional parameters for tools imported by CPTL (CoroPlus Tool Manager) in
“OptiThreading”.

Order Tool
When cutting tools are imported via catalogs that GibbsCAM supports (such as
CoroPlus Tool Library, Harvey Tool, Helical Solutions, and Garr Tool), the GibbsCAM
Tool dialog presents a link:
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Clicking the link directs you to the catalog of the specific tool library.

Advantages: Clicking the link takes you to the manufacturer’s catalog so that you can
view/inspect/compare the current tool and possibly import it from the manufacturer’s
ordering page for that tool. If you import from a catalog, GibbsCAM keeps track of the
tool’s item/catalog number and manufacturer.
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Posting and Output
GibbsCAM 2025 includes improvements and enhancements to output capabilities.

TMS now supports full WFO (Work Fixture
Offset) functionality
Where to find it: In the Post Processor dialog, choose theWorkfixtures tab.

Postprocessor support for machining
tolerance in solid ops
There are new commands for querying/outputting the operations machining tolerance,
so that you can learn (for example) whether you can turn on a particular kind of look-
ahead.

Please Note: This enhancement requires a post upgrade.
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Solids
GibbsCAM 2025 brings further improvements to solids and surfaces.

Edit Facet Bodies
Where to find it: The main tool palette has a new command:

Clicking this command opens the FB Solid Modeling palette, which lets you edit
facet bodies using most of the tools you have for solid geometry, such as: Boolean
operations (union, subtraction, intersection); Slice; Offset/Shell; Separate; Unstitch
Body; Shrinkage; History; Check Body Validity; and calculations of surface area and
volume. Just as with solid bodies, each modification to a facet body is preserved in its
History Tree. When a facet body is combined with a regular (B-Rep) solid body via
Boolean commands, the result is a facet body with a history.

The following new functions are specific to facet bodies: Heal Facet Body; Smooth

Region; Reduce Complexity; Refacet; and Tesselate.

Collision Avoidance of Fixtures
Where to find it: In many process dialogs, the Solids tab now offers a new checkbox:
Avoid IT Fixtures. For Advanced 3D processes, this checkbox is in the Boundary tab.



Solids

36

When this checkbox is enabled, collision avoidance is aware of both Intermediate
Tooling fixtures and workspace fixtures, allowing it to avoid gouging clamps, jigs, etc.

Also: In parts whose MDDs define Clearance Volume, clearance transition moves now
automatically avoid collisions with all types of fixturing if possible. For Advanced 3D
processes, you can fine-tune this by entering a value in the new Fixture Clearance text
field in the Boundary tab.
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Miscellaneous
System requirements are unchanged from GibbsCAM 2024:

• OS:Windows 10, Windows 11, or Windows Server 2022.

• CPU: Intel Core i9, i7, or i5 with four or more cores; or AMD Ryzen or Threadripper

• RAM: 16+ GB

• Video card: NVIDIA video card with 4+ GB of video memory

Third-party library support
VoluMill 9.6 is now supported.

Because GRANITE does not support importing the latest PTC Creo files, the legacy
GRANITE import options have been removed; the Spatial options are retained.

Note: Add-ins for Cimatron 15 and 16 are still supported, but they no longer appear in
the InstallShield Wizard, because they are now installed with Cimatron rather than
GibbsCAM.

Copying/pasting of solids preserves colors
and other attributes
When you copy-and-paste a solid, all attributes on the solid, faces, and edges are now
preserved, including not just Color attributes but also attributes of types Feature, Real,
Integer, and Text.

How to use it: Open two sessions of GibbsCAM. In the first session, open a GibbsCAM
part that has attributes (such as color or PLM). Copy part or all of it and then paste into
the second session.
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NLO License borrowing with
checkout/return/expiry parameters
Users can now check out an NLO license for a specified time period, then disconnect
from the network. This allows users to borrow licenses, disconnect, move their laptop,
and keep using the GibbsCAM products even when the license server is stopped.
Borrowed licenses can be returned manually, or they can be set to expire after a set
time.

Where users can find this option: Under File > Preferences > Interface, click License
Options; then, in the License Manager dialog, click Start Roaming.

How administrators can support this option: Reprise License Server Administration
shows the count of roaming licenses in its License Pool Status:
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Op Manager, Process Manager support for
VoluMill data fields
Where to find it: Open a VoluMill model and access Operation Manager or Process
Manager, as illustrated below.
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Op Manager, Process Manager support for
many 5-Axis data fields
Where to find it: Open a 5-Axis model and access Operation Manager or Process
Manager.

MDD limits on maximum spindle RPM
MDDs in GibbsCAM 2025 can set a maximum spindle RPM. Exceeding the maximum
RPM will result in a program error.

Where to find it: Machine Manager >
Tool Station tab (☑ Live Tool): Max RPM

Where to find it: Machine Manager >
Part Station tab (☑ Spins Part): Max RPM
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5-Axis
This chapter discusses the following enhancements to 5-Axis in GibbsCAM 2025.

Note: For illustrations and full descriptions of 5-Axis functions, see the 5-Axis guide.

Multiblade
Edge Rolling for Leading and Trailing Edges - With this enhancement, leading and trailing
edges can now have their own edge rolling settings. This gives users more flexibility and
allows them to define how the leading and trailing edges should be individually
machined.

Feedrate for Leading/Trailing Edge - The toolpath can now have different feedrates at the
leading and trailing edges, providing greater control. This results in improved surface
quality, more consistent cutting, and smoother machine tool movements.
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Core Technologies / Linking
Fade Lead In/Out - This new feature adds a new lead type called “Fade” that moves slowly
away from and towards the machining surfaces.

Automatic as Default - This new feature changes the default settings for the linker. Setting
the default for clearance to “automatic” results in more successful toolpath generation
without any user interaction for clearance inputs. This reduces the programming time.
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3-Axis Machining / 3-Axis
Machine Flatlands after Each Slice - The new option 'Machine Flatlands after Each Slice'
machines flatlands on top surfaces after each slice. This option, along with DHC,
enables the tool to reach deeper pockets, which would otherwise not be possible to
reach.

3D Contact Point Boundary for Finishing - The new implementation of the 3D contact point
boundary accurately limits the finishing toolpath to the 3D containment on the part,
improving the surface quality. Users only need to define the cut area on the actual part,
and the calculation automatically limits the toolpath to ensure the tool contacts the
surface exactly at all the points. Users no longer need to recreate the containment or
manually add the offsets.

Optimal XY Angle for Flatland Milling - An option to optimize the XY angle has been added
to the flatland toolpath. It adjusts the angle for separate regions independently to
optimize material removal and surface quality. This is achieved by aligning the parallel
passes with the longest length of the relevant area.

Ordering by Region - The parallel cuts toolpath can now be generated using new region-
based ordering. This provides better surface quality as there are no engage or retract
moves in a region. Each region is milled completely and then the tool moves to the next
region. This option is offered in addition to the shortest path ordering option.

Store Contact Point Normals - This new enhancement for 3-axis finishing toolpaths stores
the contact-point normals along with the toolpath in the structure. These contact-point
normals can be used subsequently for 3D cutter compensation or tilting in the 3-axis
finishing strategy.

Outside-In Ordering for Flatland Milling - This enhancement enables flatland toolpath to
order the passes from the outside to the inside of the island or region. This helps to
improve surface quality and greatly increases the tool life, because the tool no longer
engages directly on the surface from the top.

3D Machining / 3-Axis
Improved Stock Aware Linking - The stock awareness for linking has been improved. In
addition to checking against the part, in-process-stock is now also checked during
linking motions. This minimizes the number of link and ramp motions while
guaranteeing a collision-free toolpath.
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Optimized Link Height - The improved in-process-stock awareness optimizes link heights
and keeps them to a minimum. This reduces linking motions by up to 30% and
therefore reduces machining time while maintaining machining safety.

Where to find it: tab "Link" > dialog "Retracts" (lower left) > checkbox "Optimize lead
and link distances"

Optimized Ramp Height - The improved in-process-stock awareness optimizes ramp
heights and ensures the ramps start exactly at the height of the in-process-stock. This
reduces air cutting and machining time while ensuring optimized entry.

Where to find it: tab "Link" > dialog "Retracts" (lower left) > checkbox "Optimize lead
and link distances"

Smoothing Control for Offset - Offset toolpaths for complex and detailed features are
smoothed out while preserving the original last contour. This reduces unnecessary
jerking motions caused by changes in acceleration and deceleration during the
machining process and ensures constant, high-speed roughing.

Where to find it: tab "Roughing" > dialog "Advanced" > checkbox "Smooth contours" /
textbox "Smooth deviation (stepover %)"

Orthogonal Extension for Leads - In addition to the tangential extension for lead motions,
a new orthogonal extension has been added for profile passes. This is especially useful
when an extension is necessary for switching to CRC mode on the CNC machine,
because it minimizes the space needed to perform the switch. This is particularly
convenient when machining small pockets.

Where to find it: tab “Surface Paths" > dialog “Profile Pass" > textbox “Orthogonal line
length"

Corner Detection Threshold - The corner detection threshold defines the maximum
adjacent angle between adjoining faces for a pencil toolpath calculation. The toolpath is
not calculated for corners with angles larger than this threshold. By adjusting the
threshold, the user can optimize the toolpath and avoid unnecessary or undesired
machining.

Where to find it: tab “Surface Paths" (area"Surface Quality) > checkbox “Corner
detection threshold"

Optimal XY Angle - An option to optimize the XY angle has been added to the parallel
cuts pattern. It adjusts the angle for separate regions independently to optimize
material removal and surface quality. This is achieved by aligning the parallel passes
with the longest length of the relevant area.

Where to find it: tab “Surface Paths" (area"Pattern") > checkbox “Optimal machining
angle in X,Y"
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Advanced Filtering for Finishing - A new Inscribed circle option has been added to the
filtering options for finishing cycles. This provides additional user-control for filtering
unnecessary toolpath segments.

Where to find it: tab “Surface Paths" (area"Area") > dialog “Filtering" > (Filter by:
Regions) > "Type" pulldown choice "Inscribed circle"

Spiral Machining for Undercuts - Constant Z undercut machining now offers an additional
spiral ordering option for generating a spiral toolpath for undercut machining. This new
option ensures a continuous, seamless machine motion and thus improves machining
performance as well as surface quality.

Where to find it: tab “Surface Paths" (area"Sorting") > "Cutting Method" pulldown
choice "Spiral"

Report Minimum Shaft Length - A new Report minimum shaft length feature is now
available for finishing cycles. It calculates the minimum shaft length required to reach
all the areas to be processed within the specified machining height limits. The tool can
be adjusted to ensure collision-free machining.

Where to find it: tab “Gouge Check" > dialog “Advanced parameters" > checkbox “Report
minimum shaft length"

Improved Stock Aware Linking - The stock awareness for linking has been improved. In
addition to checking against the part, in-process-stock is now also checked during
linking motions. This minimizes the number of link and ramp motions while
guaranteeing a collision-free toolpath.

Where to find it: tab “Surface Paths" (area"Pattern") > DHC=dialog “Dynamic Holder
Collision" > checkbox “Check with in-process stock"

Improved Peg Loops - The corner peg loop strategy has been improved. It now merges
the peg loop segments into offset contours to avoid changes in the machining direction.
This improves machining performance and increases tool life.

Where to find it: tab “Roughing" > dialog “Advanced" > checkbox “Smooth
Links"/textbox “Smooth link gap size (stepover %)"

Adaptive Roughing
Zig-Zag Threshold - The new Zig-Zag Threshold ensures that corner regions smaller than
the given threshold are connected via the one-way trochoidal method, while zig-zag
linking is maintained for longer toolpath contours. This improves the machining
conditions while keeping the toolpath length short.
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Where to find it: tab “Surface Paths" (area "Sorting") > checkbox “Zigzag threshold" /
textbox “× Tool diameter"

Start Point Control -

Core Technologies / Tilting Core
Strict Preference for Automatic Tilting - A new feature is now available for the Automatic
tilting gouge check strategy. This feature restricts the degree of freedom for collision
avoidance to one. This allows you, for example, to maintain a constant table rotation
from the input data and use only the tilt axis to avoid collisions. Previously, the rotation
also contributed to collision avoidance, which meant the table rotation sometimes
showed reversals.

Where to find it: tab “Gouge Check" ("Tilt Tool"+"Automatic") > dialog “Parameters"
(area "Behavior") > "Preference" pulldown choice "Rotary tilt (strict)"

2D Machining / 2-Axis
External Sharp Corners for Open Ends -

3D Machining / 3-Axis
Flatland Ignore Gaps -

Report Minimum Shaft Length -

Independent Filter for Closed and Open Contours -

Corner Peg Height Control for Ball and Bull Mills -

Parallel Cuts Ordering Enhancement -

Multi-Axis Roughing / Rotary Machining
Roughing
Leads for Roughing - This enhancement adds lead-in/out options for rotary machining
roughing toolpaths. These additional motions ensure the smooth entry and exit of the
tool into and out of the material. This is especially useful for open pockets and also for
rest machining operations. It generates smoother transitions and ensures optimum start
points on open contours. Tool wear and the risk of tool damage are also reduced.
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Multi-Axis Roughing / Area Roughing
Minimize Links - This enhancement reduces the number of ramps in the multi-axis
roughing strategy by optimizing the start points for closed contours. This means that
some ramps are removed and the tool, in these cases, engages from previously cut
passes. This reduces the total cycle time of the operation while increasing tool life.

Avoid Small Profile Ramp - This improvement enables the minimum size of profile ramps
to be controlled by a parameter. This helps to avoid small profile ramps, making it
possible to use tools with wider non-cutting areas. It also improves tool engagement
efficiency, and larger ramps means less ramping time.

Trim Line Ramps - With this improvement, line ramps are now trimmed to the stock. This
ensures that the ramp length is appropriately defined according to the available stock,
which in turn reduces the overall engagement time.

Multi-Axis Roughing / Geodesic Machining
Improved Corner Smoothing - This option allows smoothing corners in toolpaths. This, in
turn, leads to better surface quality and also to shorter machining time, because the
tool does not need to decelerate and accelerate abruptly.

Improved Medial-Axis Cuts - This feature makes medial axis cuts more powerful. With this
option, users can add additional medial axis cuts that are either merged with the main
cuts or added as finishing cuts. This greatly improves surface quality and reduces the
manual effort required to clean up the cusps afterwards.

Multi-Axis Roughing / Wall, Floor, and Rest
Finishing
Stepover by Cusp Height - This enhancement adds an option for the user to define the
stepover based on the cusp height for advanced tools, such as barrel mills. With a cusp-
based stepover, users can easily setup operations and avoid mistakes in manual
calculations.

Tool Segment Selection for Tilting - This feature enables users to define tool tilting using a
tool segment when working with advanced tools such as barrel tools. This gives users
greater control over the tilting range as well as the tool contact point for operations.
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Multi-Axis Roughing / Surfaces
Slot Mill Enhancements - This enhancement introduces a new option for slot mill tools.
Users can now add chamfered edges to the tool. This ensures full coverage of available
slot mill types.

Multi-Axis Roughing / Swarf Machining
Gouge Checking against Individual Tool Parts - With this update, it is now possible to select
individual parts of the tool for collision checking. This feature gives the user more
flexibility and control over which sections of the tool are included in collision checking.

Multi-Axis Roughing / Turn Milling
Radial Cuts - This new option adds a completely new cutting approach to turn milling.
The 'standard' turn milling cuts are spirals that are created in the axial direction and
increment (depth step) in the radial direction. The radial cuts option does the opposite:
the cuts propagate slice-wise in the radial direction to the final cutting depth while a
sidestep is applied to reach the next slice.

Multi-Axis Edge Finishing / Deburring
Corner Arc Support for Chamfer Tools - This new enhancement creates a continuous
toolpath around inner and outer corners when using a chamfer mill without any
intermediate links for 5-axis deburring. This reduces the linking motions and hence the
overall cycle time for chamfering.

Multi-Axis / Automatic 3+2-Axis Roughing
Marker in 3+2 Roughing Simultaneous - Linking for the start and end of 5-axis transitions.
Clearance blend spline feedrate for 3+2 roughing

Multi-Axis / Deburring
Allow Asymmetric Edge Shape –
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Multi-Axis / Geodesic Machining
Containment Cuts Order -

Multi-Axis / Multi-Axis Machining
3D Containment Curve Offset -

Sort by Regions/Lanes - Allows the user to choose a sorting method for the finishing
cycles.

Multi-Axis / Multi-Axis Profiling
Advanced "Run tool at contact point" -

Multi-Axis / Surfaces
Leads - Tool Orientation Normal To Lead is a new orientation type for leads that keeps
the tool normal to the toolpath at all positions.

Leads - Along Tool Axis is a new lead type that follows the tool axis direction.

AT 2.0 - For Automatic Arc Leads With Automatic Tool Orientation and Barrel Tools
allows AutoTilt 2.0 (AT 2.0 to work on automatic arcs for barrel tools.
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